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Hello, Beta Tester!

Firstly, we would like to thank you for your contribution to 

the development of this tool.

We want Sub+Dub’s AV Translation Tool to be every 

Audio-Visual Translator’s favourite tool and that it can 

contribute (for real) for their work and market.

We created this User’s Manual to help you start making 

Audio-Visual Translations with Sub+Dub. We hope to 

hear about your experience, very soon.

Enjoy it!
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After downloading it, open the “Sub+Dub_v0.2.2 Beta” installer. 1. After, select the installation mode and the language 

you would like to use throughout the installation 

2.

If you prefer, you may alter the default folder where 

you will install Sub+Dub into.

3.

After clicking the installer, you may get a security alert. This is a 

normal procedure since it is a new tool. In this case, you should click 

in “More Information” and, after that, click “Execute anyway”.

How to install Sub+Dub
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Click “Create a desktop shortcut” if you want to create a 

desktop shortcut for Sub+Dub.
4. Check to see if the installation configurations are correct and click 

“Install”. Finish the installation by clicking in “Finish”.

5.

How to install Sub+Dub
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When you open the Sub+Dub tool for the first time, 

the “Ongoing Projects” window will pop up, and it 

will show you a list of your projects.

The tool will show you a list of the most recent 

projects in “Recent”, the archived projects will be on 

the “Project” tab, within your Sub+Dub documents’ 

folder and the backups.

This window will also have a “New” button, that will 

open the “New Project” window, and the “Open” 

button, that will allow you to open any document 

already saved in your computer.

Ongoing Projects

To start a new project on Sub+Dub, 

click the first icon.

Start a new project
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On the “Project” tab:

New Project 

Name the new project1.

2. By default, all projects are saved in Sub+Dub’s 

“Projects” folder. If you want to save them in a 

different location, click the “Find” button.

3. The Project Type determines if the project is a 

subtitling or a dubbing project. The programs’ 

mode changes automatically accordingly. 

4. Choose the source language of the project 

in “Original Language”

5. Choose the target language of the project 

in “Target Language”

6. Select the client’s parameters that fit the 

project in “Profile”

7. Select the type of time format of the video that you will be 

working with in “Time Format”. 

*The MS (milliseconds) mode was not fully tested, so we 

recommend that you keep it on the FRAMES setting 

1

Start a new project
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2 On the “Media” tab

3 On the “Script” tab

New Project 

Afterwards, upload the video you will be 

working with on the Media tab, by clicking 

“Open” and selecting the media file that you 

need.

In addition, while on Sub+Dub’s main page, you 

can click on “Media”, “Open”, and select the 

video file that you need.

Upload the script that you will be working with on 

the “Script” tab, by clicking “Open” and select the 

script file from its current location.

In addition, while on Sub+Dub’s main page, you can 

click on “Subtitle”, “Import”, and select the script 

file that you need.

Start a new project
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Open button

4 On the “Metadata” tab

New Project 

Choose the title for the .sdub project and write 

it on the Title box.

Bellow that, tick the box if the project is 

episodic, so, if it is part of a series or 

documentary that has more than one episode. 

If so, fill the remaining information – Episode’s 

title, Season and Episode’s number.

You may also open a previous project by 

pressing “Open” and by choosing the project 

you want.

Starting a project
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New Project

Open
Sub or Dub

Glossary

Sub Mode (Subtitling)

After you start your project, Sub+Dub will 

change its display accordingly to the type of 

project to either Sub or Dub mode.

To the left, the subtitles, which are separated 

into five columns:

Number of the subtitle1.

2. In Cue – Timecode In of the subtitle

3. Duration – Duration of the subtitle

4. Out Cue – Timecode Out of the subtitle

5. Text – The text present in the subtitle

Above the subtitles, you also have the possibility to select 

a new project, open another project, change the current 

profile, switch the current mode, between Sub Mode (for 

subtitling) and Dub Mode (for dubbing), and select the 

glossary that you want to use, by clicking the red button.

Sub or Dub? 
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Sub Mode (Subtitling)

In the centre, you will have a video 

visualization window and buttons that allow 

you to manually control the way you play it.

Above this window, there are three buttons.

1 Align existing subtitles with audio: Select this 

button if you want the tool to automatically 

calculate the Timecodes of the subtitles that are 

already translated and sync them with the video’s 

audio. (Currently, it only works with subtitles that 

have English as the source language, [as seen on 

the first box])

2 Recognize speech and Timecodes: Select this 

button if you want the tool to create subtitles with 

timecodes by analysing the text. This function 

ignores previously created subtitles.

3 Generate Auto-Translation: Select this 

option if you want the tool to suggest some 

possible translations for your subtitles.

Sub or Dub?
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Below the video, you will have two boxes: 

Original and Translation.

In the Originals one, you can see the subtitle 

with the text in the source language.

In the Translation one, you can see the subtitle 

with the translated text into the target language.

If the subtitle’s text is not translated, the box will 

appear empty, unless you have opted to create 

an automatic translation and if you have 

selected the option “Show Auto-Translation”.

In this case, a suggestion for a provisional 

translation will appear in cyan, which the 

Translator can accept, edit, or reject.

On the bottom, there will be a Wavebar that will show the audio 

of the selected video, in blue, while also showing the subtitles 

intervals, in pink. You can sync the video with the selected 

subtitle by clicking “Select Subtitle on Display”.

Sub Mode (Subtitling)

Sub or Dub?
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View

Sub Mode (Subtitling)

To the right, the Glossary will be on display if you 

have selected it on the View menu or through the 

proper shortcut. While in Dub Mode, this option is 

not selected so you can access the sources.

Below, you have the “Glossary Matches”, that 

informs the Translator of any equivalent that the 

tool might have found for the selected subtitle.

 

There, you will be able to see the original 

expression in “Original Expression”, the translated 

expression in “Translated Expression” and the 

glossary that is being used in the current project, 

in “Glossary”.

Lastly, the Translator will have a section where all 

the notes associated to the subtitles can be seen, 

in the “Selected Subtitle Annotations”. These 

notes can be a part of the original script or be 

edited and added by the Translator during the 

making of the project.

Sub or Dub?
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Sources

By switching to Dubbing mode, or Dub mode, 

the display alters slightly.

The subtitles display remains, still presenting the same 

information as in Sub Mode, but the text is highlighted, 

gaining a bigger area

There is also a new tab, “Source”, where you can see the 

character to whom the selected subtitle belongs.  

Below the subtitles, you can still see the “Original” and 

“Translation” windows, where the Translator can edit the 

text or accept the automatic translations, as described 

above.

Below the windows, you can find the Timecode In, 

duration and Timecode Out information for the selected 

subtitle.

The list of notes is now in the middle, where you can 

also see a list of all the subtitles that have annotations 

in the “Subtitles With Annotations” window, that gives 

the Translator the chance to “jump” between any 

subtitle that has annotations.

Dub Mode (Dubbing)

Sub or Dub?
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Dub Mode (Dubbing)

Source Image: Images that are attributed by the Translator to 

the selected source, so it can be easily recognized. 

To add an image to a Source, the Translator must select 

a moment in the video where the character in question 

is visible, right click the “Source Image” of the Source 

they want and select “Set Source Image.”

The image will immediately be added to the Source. 

You can replace any images by clicking “Replace” or 

dele them by clicking “Remove”.

1.

To the right, under the video, you can see the Sources 

that are a part of the project at hand.

Here, you can create or edit a sources’ file for the 

project. This window shows five different things: 

Sub or Dub?
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Dub Mode (Dubbing)

Original Name: The Source’s original name.2.

Translated Name: The Source’s translated name. 

To translate a source, click it, write the translated 

name and press “Enter”. This will automatically 

replace the name of all the selected Source’s 

subtitles.

3.

Gender: The Gender of the selected Source. By 

default, they are all set as “NONE”, but the 

Translator can change it for “M” (Male), “F” 

(Female), or “M/F” if it contains a group of people 

from both genders. 

4.

Talent Name: The name of the actor that voices the 

character in the dubbing version of the project.
5.

Sub or Dub?

16



Import Scripts

By clicking “File”, “Import Script”, the Translator will 

gain access to the “Splitter” menu. Here, the 

Translator will be able to format script files saved as 

.docx.

Translators may format the subtitles in an automatic 

or in a manual way.

They may “split” the subtitles knowing that, by 

default, this will happen automatically at every line 

break, which can be verified on the “Line Breaks” 

box.

However, the Translator might split the subtitles on 

the “Split on” window, splitting them at any of these 

symbols: full stop (.), comma (,), ellipsis (…), dialogue 

dash (-), colon (:), parenthesis ‘)’, question mark (?) 

and exclamation point (!).

On the “Toggle Selected” window, the Translator can 

select “ALL CAPS”, “Numbers” and “(In Parenthesis)” 

if they want to remove from the script any subtitle 

that is written in CAPS LOCK, that contain only 

numbers or values inside of parenthesis

Bellow, they will have the “Repeated Values” window, which 

will allow the translator to select all subtitles that might be 

repeated and that are therefore redundant, thus reducing 

the number of subtitles that they will have to format. 17



To the right, you will have the script. On the “List” tab, they may see the 

subtitles list, which will be formatted according to the selections that they 

chose.

Once the script is properly formatted and imported, 

the Translator must press “OK” and Sub+Dub will 

format the script as requested.

From this point on, the Translation may open a media 

file (if it is still not associated with the project) and 

proceed to the recognition of Timecodes of the already 

formatted subtitles with the video.

Keep in mind that the three functions that were 

mentioned on page 11 will only work if Sub+Dub is 

connected to the server.

On the “Raw Script” tab, the Translator might see the script in its 

original format, not being formatted as subtitles. 

The list of notes is now in the middle, where you can 

also see a list of all the subtitles that have annotations 

in the “Subtitles With Annotations” window, that gives 

the Translator the chance to “jump” between any 

subtitle that has annotations.

Import Scripts
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The translator might edit Sub+Dub’s settings on the 

“Edit” tab within Settings. 

Here, they may edit any and everything that they 

desire to fit their Workflow. For example, they may 

choose what is shown in each of the different Modes, 

the default Media Player, the colours and the 

Waveform’s display of the media files, the Sub+Dub 

theme and the shortcuts that can be used within the 

tool.

The “Shortcuts” tab allows the Translator to visualize 

and edit the available shortcuts, for example.

In these three tabs, “General”, Subtitles” and “Media”, 

the Translator can see all the shortcuts and keys that 

have a function within the tool.

 

These shortcuts range from general things like undo, save, run the client’s parameter 

report, to more specific things like skipping through subtitles, delete the selected 

subtitle, merge the selected subtitle with the next, alter the in and out timecodes, and 

the Media files, with the shortcuts that allow them to play, stop, to play it fast or slow, 

forwards and backwards, among others.

 

Shortcuts 
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Besides having the possibility to personalize 

up to two shortcuts for each action, all 

Sub+Dub’s shortcuts are customizable and 

adaptable to the individual preferences of 

the user.

For example, if the Translator wants to go to 

the next subtitle, they only need to press the 

8 key on the NUMPAD. However, if they do 

not have a NUMPAD compatible keyboard, 

they can press PAGEDOWN.
If the Translator dislikes both options, the 

shortcuts can be replaced. To do so, just select 

one of the shortcuts from the list, choose to 

alter the main or the secondary shortcut by 

pressing “Primary” or “Secondary” and on the 

text box press the key or keys that they want to 

attribute to the shortcut.

After they press “Apply”, the new shortcuts will 

be available immediately.

On the “Shortcuts” tab, you can reverse the changes that were done to the 

shortcuts by clicking “Default”.

On the “Reset” tab, the Translator has the option to press reset and all the 

changes will be reverted. Keep in mind that this includes all the changes that 

were made in “Settings”.

Shortcuts
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Before starting the translation, the Translator can 

select one or more glossaries that might be useful 

for the project.

To do so, if they already have a glossary in a 

.XLSX format, they only need to go to “Glossary” 

and “import from XLSX”, thus importing the 

glossary.

For example, here is a glossary that has, in its first 

line, the two languages that are being used in this 

project, en-Us to pt-BR and bellow the terms in 

the source and target languages.

If the glossary does not contain any terms or 

they want to edit it, they can do it manually.

To do so, they just need to press the “+” and a 

“Add Glossary Entry” will pop up, where the 

Translator can write the term in the source 

language and its translation into the target 

language. After, they need to select the 

glossary where they want to add the term.

After the project is finished, they can go to 

“Glossary”, “Export to XLSL” and export the 

updated glossary, which they can then use in 

other projects.

 

After the glossary is imported, it will be 

visible on the “Glossary” window, showing 

the terms in their source language and 

their equivalents in the target language.

 

Glossaries
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As was said above, the Translator can create 

different profiles, according to the parameters of 

each client. 

To do so, they must click on “Edit” and “Profiles”. 

This will open the “Profiles” window that shows all 

the available profiles.

On the “Overview” tab, you can see the name of 

each profile, the default interval between 

subtitles, the minimum and maximum duration of 

subtitles, the allowed characters per line and the 

reading speed limit.

If you want to create a new profile, just press 

“New Profile”. Then select it from the list 

and alter its name by clicking “Name”.

If you want to alter any of the parameters from this or 

any other profile, just go to “Rules”, select the profile 

in “Editing Profile” and set it, pressing “Apply” when 

you are done.

Creating client profiles
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